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22.1 Signal Integrity 

To help designers cope with the added complexity of transmission line analysis on a PCB, EDA 
vendors are starting to include signal integrity analysis software as part of the standard board 
design toolset.  

·  Unlike circuit simulation, signal integrity analysis does not concern itself with the functional 
operation of the circuit – components are only modeled in terms of the I/O characteristics of 
their pins, without regard to the component’s function.  

·  Connections between component pins are modeled using transmission line techniques that 
factor in the length of the trace, the characteristic impedance of the trace at the stimulus 
frequency, and the termination characteristics at each end of the connection.  

·  Traditionally, signal integrity tools are designed to work with a fully routed board. While this 
gives accurate results because each individual trace length is known, it does mean that the 
analysis is performed quite late in the design cycle. One of the most common signal integrity 
issues that arises is signal degradation resulting from reflection caused by mismatched 
impedances of the pins at either end of a connection. The solution to this problem usually 
involves the addition of a termination resistor or R/C network to match the termination 
impedances and minimize reflections – a task which requires modifying the source schematic. 
Altium Designer supports schematic-level signal integrity analysis, to help preempt potential 
impedance miss-matches before the board layout stage. 

 

Figure 1. Output from a reflection simulation for a problem net on a board.  
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Figure 2. Same net after the insertion of an appropriate series termination resistor.  

 
·  Using signal integrity simulation to uncover problems in a completed board design before any 

prototyping is undertaken can reduce the number of prototype iterations needed to complete a 
project. However, the addition of new components late in the board design stage can be a 
major problem, particularly on dense boards. The rework involved can be time consuming, 
partially negating the time saved in the prototype/test phase.  

·  For this module we’ll run through an exercise that takes you through the steps of setting up, 
finding and fixing signal integrity problems on a design using an FPGA, SDRAM and a 
discrete processor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Module 22: Signal Integrity 22��� 3 

22.2  Checking Signal Integrity on an FPGA 
design 

 

This tutorial relates to the following example project:  

\Program Files\Altium Designer Summer 08\Examples\S ignal Integrity\NBP-
28\NBP-28.PrjPcb  

This example is based on the daughterboard, NBP28. This daughterboard includes a Xilinx 
Spartan 3, a Sharp LH79520 incorporating an ARM 7 processor, SRAM and Flash RAM.  

In this example we are going to answer the question how hard can I drive the signals D[31..0] 
before ringing and crosstalk will prevent correct operation? Or alternatively, what is the optimum 
slew and drive settings to use for FPGA pins driving signals D[31..0]? 

 

22.2.1 Setting Up 

Before we do any analysis we need to make sure that the components connected to the signals of 
interest all have the correct models set up.  

These components are listed below.  

·  U1 FPGA - Xilinx XC3S1000-4FG456C  

·  U5 PROCESSOR - Sharp LH79520  

·  U7, U9 SRAM - Micron MT48LC16M16A2FG-75  

·  U8 FLASH RAM - AMD AM29LV640DU90RWHI  

U1 is the FPGA. Suitable pin models for all FPGAs supported by Altium Designer are included 
with the software. The actual pin model that is automatically chosen depends on the final program 
state of the device, and the settings for pin IO standard, slew rate and drive strength. Part of this 
example is to determine the optimum settings for these. 

22.2.2 Importing IBIS Models 

You will need to import the IBIS models for the other ICs listed above in order to have the pin 
models added to the SI pin model libraries in your installation of Altium Designer. The required 
IBIS models have been downloaded from the vendor websites and can be found in the \ibis 
models folder in the example project directory. The IBIS model is imported by editing the 
schematic component.  

Locate U5 on the schematics, and:  

1. Double click to open the Component Properties dialog.  

2. Edit the existing Signal Integrity model, the Signal Integrity Model dialog will open.  

3. Click the Import IBIS button.  

4. Locate and select the IBIS model file for the device.  

5. Select the correct component if a choice is given in the upper region of the IBIS Converter 
dialog.  

6. Click OK to exit the dialogs. You will be informed that the model data has been written to the 
libraries, and that the model has been assigned. A report file will open, listing which pin model 
has been assigned to each device pin.  
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7. Now repeat this process for U7, U8 and U9. Note that we are assuming that the IBIS models 
from the manufacturer accurately model the pin characteristics. As with any simulation, the 
models used are extremely important to accuracy. A simulation is only as accurate as the 
models used! 

Note:  For the SRAM, there are 3 possible IBIS model files. For this example, we will use 
y16a.ibs . 

·  Another essential requirement for successful SI simulation is to set up supply nets design 
rules for each of the supply nets (Design » Rules ), so that the Signal Integrity Analyzer will 
handle them correctly. It is particularly important to set up supply net rules for the plane layers. 
These design rules have already been configured in the example board.  

·  The layer stack for the PCB must also be defined correctly. The Signal Integrity Analyzer 
requires continuous power planes. Split planes are not supported, so the net that is assigned 
to the plane is used. If they are not present, they are assumed, so it is far better to add them 
and set them up appropriately. The thickness for all layers, cores and prepreg must also be 
set correctly for the board. These properties, as well as dielectric values, can be defined in the 
Layer Stack Manager dialog (Design » Layer Stack Manager ). All such settings have been 
defined already for the example board. 

 

22.2.3 Initial IO Standard, Drive and Slew settings  

The electrical properties for pins of the physical FPGA device are defined in the FPGA Signal 
Manager dialog Figure 3. Access this dialog from the schematic or PCB document using the 
Tools » FPGA Signal Manager menu command. 

 

Figure 3. Controlling FPGA pin electrical characteristics using the FPGA Signal Manager.  
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·  For each pin, the dialog can be used to set the IO Standard, the Slew Rate and the Drive 
Strength. The available slew rates and drive strengths will depend on the current IO Standard 
that the pin is set to.  

·  From Figure 3, you can see that the default IO Standard for the data pins has been set to 
LVCMOS 3.3V. This is the voltage level expected for the signals by the processor and 
memories in the design.  

·  The Slew Rate for each data pin has been set to SLOW and the Drive Strength to 4mA.  

·  The defined signal information is stored in the corresponding constraint file 
(IOStandardTest_1.Constraint ) for the FPGA project (IOStandardsTests.PrjFpg ), 
with the following parameters added to the corresponding constraint record for the D[31..0] 
port:  

- FPGA_DRIVE  

- FPGA_IOSTANDARD  

- FPGA_SLEW.  

 

Figure 4. Electrical characteristics added to the relevant constraint file. 
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22.2.4 Simulating the Reflecting Characteristics 

Now that things are setup we can simulate the reflection characteristics of these signals.  

Firstly, to analyze the reflection characteristics:  

1. Open one of the project documents (either a schematic or the PCB)  

2. Run Tools » Signal Integrity  

3. Click the Continue button when the Errors or Warnings Found dialog pops up. This dialog 
opens because there are components that the Signal Integrity Analyzer cannot correctly 
guess a suitable model for, in this case it is a number of test points – we can ignore these as 
they are not part of the nets we are interested in.  

Note:  The design will be analyzed and the Signal Integrity panel will open, listing all the nets in 
the design. What has happened is that a fast analysis has been performed on all nets in the 
design, called a screening analysis, with the results being listed down the left side of the Signal 
Integrity panel. Screening is used to quickly identify potential problem nets, which can then be 
analyzed in more detail. To analyze a net in more detail it is taken over to the right hand side of 
the panel, where a reflection or cross talk analysis can be performed. Note that a number of nets 
have a status of Not Analyzed, typically this is because these nets include a connector pin.  

As part of the screening analysis results, you will see that failed nets have red backgrounds to 
their cells. For Overshoot and Undershoot conditions, the Signal Integrity engine has built-in 
thresholds that it can test against. These are configured in the Set Screening Analysis 
Tolerances dialog. Access this dialog by clicking on the Menu button and choosing the Set 
Tolerances command. 

4. Locate the net D0, and click the Take 
Over button  at the top of the panel to 
add D0 to the right hand section of the 
panel. 

5. Make sure that the direction of the 
FPGA pin on this net is set to Bi/Out, 
and that all other pins are set to Bi/In. 
Note that the FPGA is component U1. 
To change this, right click in the pins 
on each pin that needs to be changed, 
and choose "Toggle In/Out" to change 
the status. The reason for this is that we want the FPGA pin to be driving the net for the signal 
integrity analysis.  

6. Click the Reflections button at the bottom of the panel to run a Reflection Analysis on the net 
D0. The resulting waveform will appear, as shown in Figure 6.  

 

Figure 6. Waveform for D0 at the FPGA pin, with Slew = SLOW and Drive = 4mA.  

 

Figure 5.Set the FPGA pin to Bi/Out, and the rest of the pins in 

the net to Bi/In. 
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7. Locate the signal D0 in the FPGA Signal Manager dialog and set the Slew Rate to the FAST 
option. Click OK and then Execute the subsequent engineering change order that is 
generated. The associated constraint file will be updated with the new setting and opened as 
the active document. Save and close this file.  

8. Display the Signal Integrity panel again (you can click the  button down the 
bottom of the workspace if you closed the panel), and click the Reanalyze Design button.  

9. Ensure that the FPGA pin is still set to be the output pin on the net (Bi/Out). Then run a 
reflection analysis on D0 again and note that there is now some ringing on this signal (Figure 
7).  

 

Figure 7. Waveform for D0 at the FPGA pin, with Slew = FAST and Drive = 4mA.  

So just how much ringing can we allow on these signals in order to avoid glitches on the input 
pins? Consulting the datasheets for components U5, U7 and U9 reveals the following 
characteristics:  

·  Maximum VIL = 0.8  

·  Min VIH = 2.0  

In the NBP-28.sdf waveform document you will find Charts for a range of possible Slew and Drive 
Strength settings. There is also a chart named "Comparison" with all the different waveforms 
combined for comparison. To scroll through the different waves, select a wave name and use the 
mouse scroll wheel or up down arrows. 

Note: The naming of the waveform in the comparison follows the following format: 
<signal>_<comp designator>.<pin>_<slew>_<drive> For example D0_U1.AA17_F_6mA is the 
waveform for signal D0, component U1, pin AA17, Fast slew rate, 6mA drive strength. 

The comparison graph was generated using the File » Export » Chart command to create a CSV 
file for each of the charts. The wave names were changed inside this file to follow the above 
convention, and then the CSV files were all imported into a new chart.  

From browsing these waveforms we can see that most of the FAST slew rate waveforms are not 
acceptable as they have excessive ringing present on the signals. With the slew rate set to 
SLOW, 6mA drive strength gives the cleanest looking waveform (Figure 8). 
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Figure 8. Waveform for D0 at the FPGA and Processor pins, with Slew = SLOW and Drive = 6mA. 

 

A drive strength of 8mA would probably be acceptable although there is some ringing (Figure 9).  

 

Figure 9. Waveform for D0 at the FPGA and Processor pins, with Slew = SLOW and Drive = 8mA. 

Any drive strengths above this generate large amounts of ringing, particularly on U5, pin 87 
(Figure 10). 
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Figure 10. Waveform for D0 at the FPGA and Processor pins, with Slew = SLOW and Drive = 12mA. 

You can see from the waveforms that the slew rate and drive strengths can have a huge effect on 
how clean the signals are. By modifying the slew and drive characteristics we can select values 
that provide a suitably fast and clean response.  

Given the above findings we would select SLOW slew rate and 6mA drive strength for the FPGA 
pins. We would definitely not want to drive it any harder than 8mA or use the FAST slew rate 
setting without adding terminations on the PCB.  

Selecting SLOW Slew and 6mA drive strength for all the FPGA signals D[31..0] in the signal 
manager we can now verify that this gives satisfactory waveforms for all these signals.  

1. Make these changes in the FPGA Signal Manager dialog.  

2. Re-analyze the design with the Signal Integrity tool.  

3. Take across signal D[31..0]  

4. Remember to check the i/o direction of the pins, make sure that for each signal the FPGA 
pins are set to Bi/Out and all other pins are Bi/In  

5. Click the Reflections button. This generates a chart of reflection waveforms for each of the 
selected signals.  

Examining the generated waveforms shows that 6mA drive strength gives acceptable waveforms 
for all these signals.  

If we wanted to drive the pins harder than this then it would be necessary to place terminations on 
the PCB. The termination advisor is a useful tool for deciding upon a type of termination to use, 
and it can be used to sweep values of termination components across a range.  

Using the termination advisor:  

1. Using the FPGA Signal Manager dialog, set the drive current for D0 to 24mA.  

2. Re-analyze the design with the Signal Integrity tool  

3. Take across signal D0.  

4. Make sure that the FPGA pin AA17 is set to Bi/Out, and all other pins are set to input.  

5. Enable all the different termination types.  

6. Un-check the Perform Sweep checkbox.  
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7. Click the Reflections button, and waves will be generated for each termination type.  

8. From the results we can see that a serial resistor looks like it will fix the ringing.  

9. In the Signal Integrity panel, disable all terminations except for Serial Resistor.  

10. Check the Perform Sweep option.  

11. Click the Reflections button.  

12. Click on the name of the first wave in the legend, and use the mouse wheel to scroll through 
the waves for different termination resistance values. It would appear that a value around 47 
Ohms would work well, so lets perform a reflection simulation with this value.  

13. Uncheck the Perform Sweep option.  

14. Change the value of the Serial Resistor to 47.  

15. Run the reflection analysis.  

As you can see, this can be a useful tool for selecting terminations in order to solve SI issues. The 
values used for each sweep are shown in the waveform hint for each wave. In the above example 
we can see that a value of 47 ohms for the serial resistor should provide a good termination if we 
needed to use the high drive current option for the FPGA output pin. In NBP-28.sdf there is a 
chart named Comparison2. This contains a comparison of the 24mA drive current terminated with 
a 47 Ohm serial resistor with the 6mA drive current waveforms (Figure 11). 

 

 

Figure 11. Waveform for D0 at the FPGA pin, with Slew = SLOW, Drive = 24mA and 47Ohm Series Resistor. 

There is not much difference between these signals, so unless we needed the higher drive 
current we are best off sticking to the 6mA and avoiding the need to add termination resistors. 

22.2.5 Checking for Crosstalk 

Finally we will look at how to examine the crosstalk between signals. Given that we were able to 
choose drive and slew settings that minimized ringing on the signals, crosstalk problems should 
have already been minimized.  

There are essentially two stages in performing a crosstalk analysis. First, we must identify the 
nets for which crosstalk may pose a problem. Then we must take over the nets which we want to 
more closely examine, and run a detailed crosstalk analysis. 
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22.2.6 Finding coupled Nets 

The Signal Integrity panel 
includes a feature that enables 
you to quickly identify which nets 
are considered to be coupled, to 
the selected net(s) you choose 
in the screening analysis results 
area of the panel. This feature – 
Find Coupled Nets – is ideal for 
working out which nets may be 
susceptible to crosstalk. It 
essentially analyzes the PCB 
and identifies traces that run 
parallel to each other according 
to coupling options defined on 
the Configuration tab of the 
Signal Integrity Preferences 
dialog (Figure 12). Access this 
dialog by clicking on the Menu 
button in the panel, and 
choosing Preferences from the 
resulting menu. 

Two options constitute the coupling criteria:  

·  Max Dist . – this option defines the proximity for neighboring nets. Only nets within the 
specified distance of the selected base net will be considered for coupling purposes.  

·  Min Length – this option specifies the minimum length that traces of nets must run parallel to 
that of the selected base net, in order to be considered coupled.  

As a general rule, the closer the traces the more likely crosstalk is to occur. Similarly, the longer 
the parallel sections of trace, the more crosstalk will occur. 

Note:  When running a crosstalk analysis, the typical number of nets taken across would be three 
– a net and its two immediate neighbors. 

To illustrate the power of this feature, let us find all nets coupled to the net D5 (our base net). The 
default setting for the Max Dist is a little high and would easily find all nets in the D[31..0] bus, as 
well as many others. Instead, we will vary Max Dist – using 20mil and 10mil values – and observe 
the resulting nets that are deemed to be coupled. In addition we will set the Min Length to be 
50mil (i.e. any nets not having traces running parallel to D5 for at least this distance will not be 
considered coupled). 

To find coupled nets with Max Dist = 20mil, Min Length = 50mil:  

1. Change the Max Dist coupling option to 20mil  

2. Change the Min Length coupling option to 50mil 

3. Select net D5 in the screening analysis region of the Signal Integrity panel  

4. Right-click and choose Find Coupled Nets  

5. Observe that the following data nets – D1, D4, D6 and D7 – are all found to be coupled to D5 
and are selected ready to take across for a more detailed crosstalk analysis (Error! 
Reference source not found. ). Net A17 is also found to be coupled, but as we are interested 
only in the data lines, this should be deselected prior to taking the nets across.  

 

 
Figure 12. Set criteria to identify coupled nets. 
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Figure 13.  Nets coupled to D5 (Max Dist = 20mil, Min Length = 50mil). 

To find coupled nets with Max Dist = 10mil, Min Length = 50mil:  

1. Change the Max Dist coupling option to 10mil 

2. Change the Min Length coupling option to 50mil  

3. Select net D5 in the screening analysis region of the Signal Integrity panel  

4. Right-click and choose Find Coupled Nets  

5. Observe that the following data nets – D6 and D7 – are all found to be coupled to D5 and are 
selected ready to take across for a more detailed crosstalk analysis (Error! Reference 
source not found. ).  

 

 

Figure 14. Nets coupled to D5 (Max Dist = 10mil, Min Length = 50mil). 
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22.2.7 Performing Crosstalk Analysis 

In the previous section, we used the Find Coupled Nets feature to identify nets coupled to the net 
D5, and that may suffer from the effects of crosstalk. We will now perform crosstalk analysis to 
assess the level of crosstalk involved when the net D5 is set to Aggressor and is driven at 
different signal strengths. Note that although several coupled nets were found by the Find Couple 
Nets feature, we will concentrate on just examining D5 and D6, since these two nets run parallel 
to each other for much of their length.  

1. Set the drive current of D5 to 6mA.  

2. Analyze the design using the Signal Integrity tool.  

3. Take over signals D5 and D6.  

4. Make sure that all the FPGA pin directions are set to Bi/Out.  

5. Right Click on D5 in the list of nets and select "Set Aggressor". This means that during 
crosstalk analysis we will be driving this net and simulating its effect on the other "victim" nets.  

6. Click the Crosstalk button to run a crosstalk analysis.  

7. In the generated chart we can see that up to about 125mV is induced in D6. (see chart 
"Crosstalk Analysis 6mA"). This maximum occurs at pin 79 of component U5 (Figure 15). As 
anticipated it should not be enough to cause any problems.  

 

Figure 15. Crosstalk induced in D6 by D5 (D5 driven at 6mA – max crosstalk on pin 79 of U5).  

If we repeat the above steps but with 24mA drive strength for D5 we see that the simulation 
waveforms show up to about 500mV is induced in the coupled nets (see chart "Crosstalk Analysis 
24mA"). This maximum is again found on pin 79 of component U5 (Figure 16). This is quite 
significant and would certainly be likely to cause problems on the signal D6. 

 

Figure 16. Crosstalk induced in D6 by D5 (D5 driven at 24mA – max crosstalk on pin 79 of U5). 

You can experiment further with other slew and drive settings in the FPGA Signal Manager dialog 
and see the effect on crosstalk. 
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22.2.8 Summing Up 

In conclusion we have used the Signal Integrity tool to find the optimum drive and slew settings 
for the FPGA pins D[31..0]. In this case we chose a SLOW slew rate and 6mA drive strength. We 
have also used the termination advisor to choose appropriate terminations if the higher drive 
current is required. We have also looked at how to assess crosstalk between signals.  

For detailed information on the Signal Integrity panel, press F1 while the panel has focus. Use 
the available link in the upper region of the Knowledge Center panel to access the relevant topic 
for this panel, within the Altium Designer Panels Reference.  

For conceptual information regarding what is required to address possible signal integrity issues 
that may arise in a design, refer to the article Putting Signal Integrity in its Place.  

For further tutorial-based information on Signal Integrity – including pre- and post-layout analysis 
– refer to the Performing Signal Integrity Analyses tutorial.  

For further information on working with generated waveforms, refer to the application note 
Working with the Sim Data Editor. 


